
Care of Expensive Precision Equipment in Cory 111 Lab 

Manual for Qualified User Quiz 
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Background:  The Cory 111 RF Electronics lab has 4 network analyzers and 4 spectrum analyzers which were 
generously donated by Agilent in 2007.  These are precision high-quality pieces of test equipment, and very 
expensive.  Although most students recognize this, they might not realize that the calibration standards and 
cables are equally precise, critical components of a successful measurement - and they are also quite expensive. 
 
The real problem however, is that a bad cable or connector can get in a lab and ruin the connector it’s plugged 
into ... and that can spread like a virus throughout the lab.  By the Fall semester of 2012, of the 13 calibration 
standards we have in the lab, 7 were broken.  A network analyzer was also broken.  (Calibration standards come 
in a kit, which costs upwards of $3000.  You can look up prices for any equipment in our lab, on the Agilent web 
site.  Sending a network analyzer back for repair costs $4700.)  In addition, of the 20-odd SMA cables, 12 were 
out of spec (this was the culprit that caused the virus) and 5 were of poor phase stability. 
 
There is no money in the Instructional Labs’ budget for repairing equipment.  We’ve asked Agilent for a further 
donation to fix many of these things, and fortunately they have again been very generous.  Also, the company 
which manufactures the test cables for Agilent, Scotts Valley Magnetics, has also been generous in donating 
cable and knowledge so that we can make our own cables and keep things working well in the lab. 
 
Plan:  Going forward, we are going to institute a training program similar to the procedures used in the Nanofab, 
where the general strategy is that students pass knowledge of equipment care on to other students in an “each 
one, teach one” fashion.  Anyone who wishes to use the equipment in the Cory 111 lab (i.e. become a Qualified 
User), must go through this training which consists of: 
 
 1)  Contacting another Qualified User to get a demonstration of how not to break the equipment 
 2)  Reading this manual & the Agilent Connector Care handout, and then completing a written quiz 
 3)  Contacting a Super User to meet for a hands-on qualification quiz/checkout 
 
As Super Users graduate and leave, Qualified Users are expected to step up and volunteer to become Super 
Users.  Hopefully, passing knowledge on in this manner will keep the equipment in good shape and help 
everyone who needs to use the equipment. 
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Topics in How to Not Break the Expensive Equipment 
 1)  The worst:  crushed fingers in female 3.5 mm calibration standards 
  a)  Culprit #1:  SMA cables’ pin-depth gage measurements out of spec 
  b)  Culprit #2:  Users incorrectly rotating the 3.5 mm standard when attaching SMA cables 
 2)  How to clean the equipment connectors without leaving lint 
 3)  How to “see” broken connectors & crushed fingers under the stereo microscope 
 4)  How to use the pin-depth and dielectric-depth gages to measure SMA cable connectors 
 5)  How to properly use 2 wrenches (torque wrench and open-end wrench) to make connections 
 6)  How to store calibration standards with their red plastic end caps 
 7)  How not to touch the end faces of connectors with oily fingers 
 8)  Why to always use test-port savers 
 9)  How to use the ECal spanner wrench and how to support the ECal when attaching it to the analyzer  
 10)  How not to drop the ECal on the floor (which is probably how it broke last summer)  
 11)  How not to attach a 50 ohm calibration standard to your amplifier’s output 
 12)  How to avoid putting too much power from your circuit into the network analyzer (probably how it broke) 
 13)  How to touch the center conductor of any connector to VNA case ground, to protect against static zapping 
 
Topics for How to Fix It If It’s Broken 
 1)  How to measure cable stability on the network analyzer to see if your cable is bad 
 2)  How to make your own brand new high-quality SMA cable using semi-rigid coax 
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All of our coax cables are male-SMA-to-male-SMA cables.  

Our network analyzers have female N connectors, to which we usually attach male-N-to-female-SMA adapters.   

Make sure that none of the adapters have rubber 
gaskets down at their bottom.  Those are made for 
outdoor applications and require a different torque 
setting.  You can pull the gaskets out with tweezers.  If 
they’re left in, and not fully torqued, they make poor 
(intermittent) connection and don’t work. 

The calibration reference plane of a male N connector is 
the plane coincident with the edge face of this metal 
ground ring surrounding the center signal pin. 

The mating surface on the female connector is another 
metal ring down at the bottom.  However, we won’t 
usually be calibrating directly at this port.  We usually 
want to calibrate so as to move the calibration reference 
plane from this plane to the far end of our male-male 
SMA cables. 
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Inspect both ends of the male-N-to-female-SMA adapters. 

Not just this male-N side 

...but also the female-SMA side 

Here’s an old adapter taken off of 
one of the analyzers in our lab.  
It’s probably been on there since 
the equipment was donated in 
2007 (this picture is taken at the 
end of 2012).  Notice all the bits 
of metal debris on the surface of 
the white plastic. 

This is a brand new adapter. 

Close-up of the old adapter.  Time to clean it.  
All these metal bits change the 
electromagnetic environment from what we 
would assume to be a uniform transmission 
line of coax cable. 
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Sometimes however, we use male-N-to-male-SMA adapters ... for instance, when we want to test our test equipment. 
At bottom right is an ECal (electronic calibrator), which has gold female connectors on each port. 

The ECal can plug directly into the male-N-to-male-SMA adapter.  I thought it 
would be good to test the Ecal this way, as it minimizes the number of cables, 
adapters and connectors.  Unfortunately, I bought some cheap male-N-to-
male-SMA adapters and they broke when I torqued them.  It’s worth it to buy 
the more expensive male-N-to-male-3.5mm adapters that are made for test 
applications.  Maury Microwave sells them for $80 - $200 each.  Otherwise, 
stick with the male-N-to-female-SMA adapters. 

These male-N-to-male-SMA adapters have rubber 
gaskets on the SMA side too.  All SMA connectors 
have rubber gaskets, but SMA connectors have 
flats so are easier to tighten to their specified 
torque. 
 
Specifications on torque: 
N connectors:  12 in-lb 
3.5 mm connectors:  8 in-lb. 
SMA connectors:  5 in-lb. 

male N side male SMA side 
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Clean the connectors by first blowing on them with a 
short burst of clean dry air.  Cans are availalbe at Ace 
Hardware on University Ave.  Use sparingly.  Let’s make 
the cans last as long as possible. 
 
Then, use a lint-free swab (you can buy them from 
Texwipes via Amazon) and moisten it with isopropyl 
alcohol.  Look at the connector under a microscrope 
and brush the swab over the dielectric, around the 
center conductor. 
 
Blow dry.  Check again under the microscope to make 
sure they’re clean. 
 
Also, make sure the connectors are dry before you 
thread them onto anything. 
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We have 1 electronic calibrator (Ecal) and 2 mechanical calibration kits:  85052D and 85033E.  The 2 mechanical 
calibration standard sets come in both female and male 3.5 mm connectors.  The inner diameter of the outer shield is 3.5 
mm.  These 3.5 mm connectors use air as the dielectric insulator between the center signal pin and the surrounding 
ground cylinder.  3.5 mm connectors mate with SMA (Sub-Miniature A) connectors.  The only difference between the two 
types of connectors is that SMA connectors use a plastic teflon-like dielectric insulator.   
 
People often use the verbal shorthand of “SMA” when referrring to a 3.5 mm connector, but they’re technically different.  
Because of their air dielectric, 3.5 mm connectors are rated to 26 GHz and  used on test equipment for precision 
measurements.  SMA connectors on the other hand, because of their plastic dielectric, are rated to only 18 GHz.  
However, SMA connectors are more widely used in commercial applications because they’re cheaper. 

85052D 3.5 mm cal standards 

85033E 3.5 mm cal standards 

Ecal 
(This is Joel Dunsmore’s that he lent us while 
ours is being repaired.  This is model N4691-
60003 which is spec’d to start at 10 MHz, 
whereas ours is the newer N4691-60006 which 
is spec’d to work as low as 300 kHz.)   
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The actual coaxial transmission line consists of this outer 
ground cylinder here 

... and this center signal conductor here.  The dielectric 
between them is air, in a 3.5 mm connector (an SMA 
connector would have teflon for the dielectric). 

This outer portion is the nut on this 
male connector.  The nut is not 
actually part of the uniform 
transmission line (although it does 
connect electrically to the outer 
cylinder). 

3.5 mm calibration standards 



Calibration standards (from the 85033E kit):  Short, Open, Load and Thru (SOLT) 
 
The black plastic thing is just a holder which keeps the short, open and load standards of a 
kit together.  It’s called an SOL holder. 

Female 3.5 mm Short/Open/Load standards 

Male 3.5 mm Short/Open/Load 
standards have nuts which you can fit a 
torque wrench onto 

Female-to-female 3.5 mm Thru standard 

SOL labels 
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Female 3.5 mm  connector on one end of a Thru std Male 3.5 mm connector on a Short std 

Female Open, Short, Load standards 

Female-female Thru standard and male Short standard 
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Get in the habit of looking carefully at the calibration standards before you use them.  Look at them under the 
stereo microscope, with the microscope light on.  Hang the stereo microscope head over the edge of the table so you 
have plenty of distance to hold the standard and move your hands up and down to change the plane of focus so that 
you can see all the way to the bottom of these 3.5 mm connectors’ insides. 

This Open is broken.  It’s 
completely missing its insert.  
We wasted hours and hours 
trying to calibrate with no 
success, before we noticed. 

A female standard should look like this.  It should 
have this female center insert that accepts the male 
signal pin from the mating male connector. 
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From the 85033E service manual:  

First, you do a preliminary connection, using just your fingers: 

Then you do the final connection: 
Open-end 7 mm and 8 mm wrenches 

Torque wrench 

http://cp.literature.agilent.com/litweb/pdf/85033-90028.pdf 
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Always hold the torque wrench past these grooves ... 

... because torque is the product of force and distance: 
                                        τ = F*r 
The calibration standards are all designed to be torqued to 0.9 Nm (which is 8 inch-lbs.) 
The torque wrench supplied with the calibration standards is designed to be held behind these grooves. 
The torque wrench will begin to break at 0.9 Nm, which requires only a small force when held at that 
distance.     

Don’t hold the torque wrench here.  
Holding the torque wrench at too 
short of a radius sometimes leads you 
to accidentally override the ball joint 
mechanism that creates the breaking 
at the torque setting. 

male-N-to-male-SMA adapter 
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Here’s an example of busted a male-N-to-male-SMA.  It was an old adapter I 
find lying around the lab (might have been slightly bent or damaged).  It 
required quite a bit of torque to tighten the nut, and made a scraping sound.  
The male nut came off the SMA end of the adapter because the nut was held 
on by this retaining ring which couldn’t handle the amount of force applied to it 
when the nut was over-torqued. 

wrong 

male-N-to-male-SMA adapter 

male-N-to-female-SMA adapter 

female standard 

What can go wrong will go wrong. 

Whenever you have one bad connector in your lab, its effects can spread like a virus and ruin all tje cal standards 
and cables in the lab.  This is because the shoulder on each male pin is supposed to be flush with the outer coax 
ring (or a little negative below it).  If its shoulder sticks out positive, it can compress the mating ring of the female 
cal standard (pic at upper left).  Then your cal standard no longer has the offset length it was calibrated at. 
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Standards should screw on easily with your fingers.  Only the last tiny bit should need 
the torque wrench. 
 
Don’t insert the torque wrench to a starting position >90o.  You won’t be applying a 
pure torque.  This scenario ends up also applying a force in the vertical direction: 

>90o Don’t do this: 
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The network analyzer is a precision measurement instrument.  All 
connectors and calibration standards need to be tightened precisely 
with a torque wrench (to keep the length of internal transmission 
lines fixed to a precise length).  Never over-torque the torque 
wrench – stop just as it starts to break. 
 
Always use a second open-end wrench to hold the calibration 
standard.  Don’t rotate the standard, rotate the nut.  If you rotate the 
standard, the center signal pin’s gold plating will wear out.  
 
Calibration standards have flats for an 8 mm open-end wrench: 

flat 

8 mm open-end wrench 

Always use an open-end 
wrench to hold the standard 
motionless.  Insert the 
torque wrench on the nut so 
the starting angle is <90o. 

<90o 
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The adapters have flats on both ends for an open-end wrench: 

flats 

However, you need to use a 7 mm wrench for these 
adapters.  Put the wrench on the flat closest to the end 
you’re connecting to. 
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Prevent Equipment from Getting Zapped! 

Touch the Center Conductor of Any Cable or Connector to Case Gnd Before Connecting 

Case ground 

Case ground 

Case ground 

Discharge the center 
conductor before 
connecting 

By Fall 2012, both the ECal and Port 1 of this network 
analyzer had broken.  It’s possible this was how they 
broke.  Agilent charges $4700 to fix anything, before they 
even look at it.  Our budget is $0.00. 



Here’s a male Open (85052D standard): If you just touch the center pin lightly, it moves. 
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Sometimes you think a connector may be bad, but in this case, it’s just the way it’s made: 

Similarly here’s a female Open (85033E standard): Its center pin moves too. Insulator in an Open standard is a 
little bit flexible.  Be careful with 
these 3.5 mm Open standards. 

Be very gentle with these 3.5 mm precision connectors.  They’re expensive and easily broken! 
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This is the 85052B cal kit, which Agilent sent us as a loaner for two weeks in Jan13.  This particular cal 
kit comes with pin-depth gages for 3.5 mm connectors: 
http://cp.literature.agilent.com/litweb/pdf/85052-90077.pdf 

Agilent sells pin-depth gages for verifying that your 3.5 mm standards are good:  

One gage measures pin depth for male 
3.5 mm connectors, the other measures 
pin depth for 3.5 mm females. 

First, you connect a gage 
blocks to the gage and 
then you zero the gage.  
Then you connect your 3.5 
mm standard and see if its 
pin depth is within spec. 



23 Diagram from Agilent App Note 1287-1 
http://cp.literature.agilent.com/litweb/pdf/5989-4840EN.pdf 

The calibration reference planes on these 3.5 mm male and 
female standards are here.  These planes are where the 
ground connection will mate to your corresponding 
opposite-sex test cable  connectors. 

This shoulder of the male 3.5 mm connector’s center pin is supposed to 
be within a specified tolerance distance behind the plane of the end 
face of the surrounding coax ring (where the red arrows are pointing).  
The spec is published as a standard and it’s a tighter spec for 3.5 mm 
connectors than for SMA connectors, which is why 3.5 mm connectors 
are considered “precision” connectors for test and measurement. 

“Pin depth” refers to the distance the center pin is above or 
below the plane of the end face of the surrounding cylinder: 
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Close-up of the male 3.5 mm connector: 
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Close-up of the female 3.5 mm connector: 
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Agilent gives these instructions for understanding the uncertainty of measurements using 
one of these gages, so  that you can determine if your 3.5 mm cal standards are within spec: 
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Cables 

Quote from Dunsmore book (p. 197): 
 
“Cables are like dogs; either they are bad, they’ve been bad or they are going to be 
bad, and when they’re good, they only stay good with great care.” 



28 

Agilent tech support says that you need a separate gage kit to measure SMA connectors.  They recommended 
Maury Microwave (maurymw.com).  This is the A027A kit ($1300) which has 4 gages so that you can measure the depth 
not only of the male and female pins, but also the depth of the dielectric. 
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We recently purchased one of these sets.  Also shown is a cable we made which passes both the dielectric depth and pin depth tests.    
Look at the manual for this A027A set on the www.maurymw.com web site.   

Use the gage master to zero each gage first.  One end of the gage master is for the 2 gages that measure male connectors.  The other 
end of the gage master is for the 2 gages that measure female connectors.  The gages themselves are inscribed with either MD, MP, FD 
or FP for male or female and dielectric or pin, respectively. 

Hold the gage and gage master like this, so that you 
apply purely axial forces. 

Untighten this black knob, so that you can rotate 
the display’s outer black ring.  Adjust the ring to line 
the 0 on the display with the needles.  Then re-
tighten the black knob. 

http://www.maurymw.com/
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This gage is inscribed “MP” which means it’s the gage for measuring a male SMA connector’s pin depth.   

MP   Note here, that this says that the distance between the 2 smallest divisions 
on the dial represents 0.0005”, or half a mil.  A mil is 0.001”.  The way to 
remember how long a mil is, is that a sheet of paper is 4 mils thick, and a 
sheet of paper is 100 um thick.  So 1 mil = 25 um.  So what is this gage 
reading?  It’s reading 3 mils.  That means the shoulder of the pin is 3 mils 
recessed lower than the SMA’s mating plane.  Good. 

Your measurements on your cables should never be on the minus side of zero.  Don’t let any such cables be in the lab! 
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SMA connectors have much looser specifications than 
3.5 mm connectors. 
 
This set of drawings is from MIL-STD 348A which is 
the standard for SMA connectors.  The tolerance spec 
for the pin depth is +0.000”, -0.010”.  This means the 
shoulder can’t stick out at all and it can only be inset 
less than 10 mils.  The gages in the 85052B kit only 
read to +-0.005” (+- 5 mils).   
 
I bought some Emmerson cables which are so far 
negative, they don’t even read on the scale of the 
85052B gage (but they could be within spec).   
 
Also, all SMA connectors have a dielectric which the 
3.5 mm connectors don’t, and so there is a spec in this 
SMA standard for the tolerance on the distance the 
dielectric face can be with respect to the reference 
plane (+0.000”).  Actually, you’re supposed to buy 
special gages for SMA connectors (Maury Microwave 
sells such gages). 
 
Note that the rubber gasket is actually part of the MIL-
STD 348A SMA connector spec. 

MIL-STD 348A  
(Google it.  I found this copy at carlsonmfg.com) 

SMA connector specification: 



32 

This is a close-up view of an SMA connector that’s more or less made correctly: 
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Here are some close-up views of really bad SMA cables.  
These were hand-made in a Cory research lab.  There’s 
a learning curve to crimping such cables and 
assemblying them correctly.   
 
Notice how far out the shoulder of each center pin 
protrudes from the end face of the surrounding 
cylinder. 
 

Throw these cables away.  If you screw cal standards 
into one of these, or attach one to the test port of a 
network analyzer, and then torque them tight, you’ll 
ruin the mating connector.  The mating connector’s 
female center receptor will get squashed and won’t be 
the proper length to make a uniform transmission line. 
 
That means you’ll get reflections, or worse, flaky 
intermittent problems that are hard to debug. 
 
Always inspect a connector or cable under a stereo 
microscopre before you attach anything to it. 
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Good test cables can range from $150 to 
$400 each.  They’re expensive because the 
dielectric has been melted/flattened so 
that it doesn’t stick out beyond the mating 
plane, and because they usually have 
armor with many layers of jacketing near 
the ends so they can’t get kinked. 

armor 

Multiple layers of heat-shrink 
jacketing over the armor. 
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These connectors looked to be of high quality.  The center 
pin’s shoulder looked even with the surrounding gold 
cylinder’s end face, but after measuring with the gage set, 
they turned out to be out-of-spec.  I threw this cable in the 
garbage. 
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Crushed fingers:  If your SMA cables are out of spec (the male pin protrudes in the positive direction), then if you 
connect your SMA cable to a female 3.5 mm calibration standard, you can ruin the standard, by breaking the fingers 
inside the center conductor which are designed to accept the male pin.  Calibration standards are very expensive, so 
always check your SMA cables (visually under a microscope and with a pin-depth gage) before attaching to a 
calibration standard.  
 
Here’s a female calibration standard that’s been destroyed: 

Close up of 
broken fingers 

3.5 mm female calibration standards use what are 
called precision connections for the center 
receptacle. There are fingers which expand, in order 
to accept the male pin, but they’re inside a solid 
cylinder which doesn’t expand.  Consequently, the 
geometry of the electric and magnetic fields to 
propagate along the air dielectric stays uniform in 
the region of the air dielectric. 

This finger has been broken because a male pin’s 
shoulder which protruded too far hit it and when 
the two mating connectors were tightened, they 
squished the finger down into the hole. 

The finger is folder over and smushed down in here. 
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Pre-testing:  Checking Your Cables’ Phase Stability Before Starting a Calibration 
 
But before that ... Check that your network analyzer isn’t broken! 

Hit the Preset button.  Select OK.  Displays LogMag S11. 
Repeat for LogMag S11, S12 and S21. 

For S12 and S21, make sure to hook up a cable 
between Port 1 and Port 2.  For example, hit the 
Meas key, and choose S21.  LogMag S21 looks like 
this (very close to 0 dB for all freqs) as nearly all the 
signal from Port 1 makes its way to Port 2: 
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We have 1 broken network analyzer in the lab:  Network Analyzer C   
On this one, if you hit the Preset button and then select OK, it comes up saying that LogMag S11 is greater than 0 dB for 
some frequencies, even though nothing is connected to Port 1!  It also says there is 30 dB of loss at 100 kHz.  If you 
display LogMag S22, you’ll see that Port 2 is not broken.   Someone probably put too much power into Port 1.  This can 
happen if you hook up the output of your amplifer to Port 1, where you have too much input power to your amp. 

It says here:  max input power is 26 dBm.  How many watts is 26 dBm? 
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When testing an amplifier set the output power from the network analyzer (which will be your input power to 
your amplifier), from the Sweep Setup menu.  Hit the Sweep Setup hard key to get to the Sweep Setup menu: 

Sweep Setup hard key 

In the Sweep Setup menu, 
select the Power soft key 
item: 

The default is 0 dBm (fine for 
testing passives).  Type in a 
lower power setting, based 
on your amplifier’s gain. 
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To test our cables, we want to look at the Phase of S21.  Hit the Format key and 
choose phase.  The sweep here is up to 4.5 GHz, so phase wraps around about 
14 times at that frequency for this particular length of cable. 

Hit the Display hard key.  Choose: 
Data->Memory  
 
Under Dat Math, choose: 

Data/Memory  

That will make the Phase S21 trace 
become zeroed:  
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Zoom in.  Hit the Scale hard key.  Set the scale to 1 degree/division: 

Now wiggle and bend the cable.  The phase 
changes as you bend or stretch the cable. 
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Now stop touching the cable.  Wait for the trace to settle.  Now the phase goes a bit negative by the time the sweep reaches 4.5 GHz.  Check 
how far off the phase is from zero at your frequency of interest.   
 
Once you calibrate, and start moving the cables all around, this different bit of phase each time you change calibration standards and move 
the cables around during a calibration procedure, is going to get incorporated into the calibration’s error-correction coefficients. 

Try it again.  Wiggle the cable around some more, then take your hands 
away and see where it settles.  This time we see a bit of positive phase 
at the upper frequencies. 

Expensive cables are usually expensive because they have 
good phase stability. 
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Dunsmore Advice on Pre-Testing Cables  
(from the Agilent web forum) 

“To test the cable:  Place the cable on one port of the VNA, attach a Short or Open standard from a calkit on 
the other end.  Don't cal.  Just do Data->Mem and Data-Mem (that's right, Data -Minus- Memory).  Look at the 
result in dB.  Immediately after that, the trace should show -70 or -80 dB return loss.  Now flex the cable back 
and forth and up and down.  The trace for a "GOOD" cable should be -50 dB.  If the highest spot on the trace is 
above -30 dB it is a "BAD" cable.  Take a wire cutter and immediately cut the cable in 20.  For me, I would not 
use a cable that is worse than -40 dB.” 

Let’s do this test on a few cables in our lab... 
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Short standard 

LogMag S11 
(ref set to -50 dB,  
scale set to 10 dB/division) 

Phase S11  
(ref set to 0 dB,  
scale set to 1 deg/division) 

Just after Data->Mem for each window, 
and Data-Mem for the top, and 
Data/Mem for the bottom 

Now after wiggling and letting it settle. 
 
This cable is really bad. 

Cable #12 
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Short standard 

LogMag S11 
(ref set to -50 dB,  
scale set to 10 dB/division) 

Phase S11  
(ref set to 0 dB,  
scale set to 1 deg/division) 

Just after Data->Mem for each window, 
and Data-Mem for the top, and 
Data/Mem for the bottom 

Now after wiggling and letting it settle. 
 
This cable is pretty good. 

Cable #2 
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Here’s a very good cable (brand new, $50, came with a sheet showing its factory test). 

Just after saving into memory, before wiggling: 

After wiggling and letting it settle.  Below -50 dB for all freqs up to 4.5 GHz.  Good. 



A Third Cable Test – the SWR Test 

This is probably the best test.  The SWR test is the way Scotts Valley Magnetics and SanTron, two high-end 
cable assemblers, test their cables: 

• Attach your cable to Port 1 of the network analyzer 
• Attach a 50 ohm cal standard to the other end  

• A perfect cable and 50 ohm load would show an SWR of 1.00 
• Under the Format menu (Format hard key), select SWR 
• If the SWR measurement is under 1.22, SanTron says it’s a good cable (albeit they measure to 20 GHz) 

47 



48 

Should say “SWR”. 

Hit the Scale hard key.  You’ll see the defaults for 
an SWR format are:  the Reference Position is 
set to the 0th division.  The Reference Value is 
1.00.  Then set the Scale/Div to 0.1: 

The yellow triangle marks the Reference 
Position for the yellow trace.  Here, the 
Reference Position is at the 0th division. 

You shouldn’t need to calibrate the network analyzer to do your cable pre-testing.  The default factory setting 
(hitting the Preset hard key) should be a good enough calibration setting to test your cables for whether you should 
throw them in the garbage or not. 
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Of course, if you do this test with the exact same cable, on the broken network analyzer (Network Analyzer C), 
you’ll get some crazy results.  

Network Analyzer C’s Port 1 says that this 
same cable  has an SWR of 3.4! 
 
If you calibrate this network analyzer before 
you test the cable, you won’t get such a bad 
reading.  However, the calibration will work so 
hard to “fix” the errors, that subsequent 
measurements will always have dynamic 
range degraded. 
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Cables are really bad if the male pin’s shoulder sticks out beyond the reference plane, since that can 
damage cal standards or test port savers.  Don’t use those. 
  
Other cable problems can be calibrated out to some extent.  That is, as long as the trace is stable, then 
any mismatch, phase delay and loss can be calibrated out.  But if they cables aren’t stable, they’ve 
probably been crimped or cracked and have intermittent connections. 
 
When you’ve achieved a “good” calibration, it can last for a week or two because the network analyzer 
itself is a fairly precise instrument, but we often change our setups so this is moot. 
 
Re-calibration should be done if you dis-connect and re-connect cables, or if you change the frequency 
sweep settings such that the sweep is over a larger range than when calibration was done. 
 
Calibration does not have to be re-done however, when simply changing the output power level of the 
analyzer (e.g. for amplifier measurements).  Older analyzers used to require re-calibration after a power 
level change, but our E5071Cs don’t need to be re-calibrated after changing the power level. 
 
Final caveat:  if you’re in a room with air conditioners turning on and off, very precise measurements can 
sometimes detect that temperature change. 

When are “bad” cables okay to use?    When do you need to re-calibrate? 



Making Our Own High-Quality Cables 
 
Buy these captivated contact connectors from Amphenol RF:  #901-9808 (from Rfdepot.com) 
They’re to be used with 0.141” diameter conformable cable.  Buy Belden #1673A (from Tallycom.com). 
Buy bend-and-stay wire from McMaster.com:   #8872K75 
 
Tools to put these together are now in the Cory 111 lab. 
 
Use the SanTron assembly tool:  #1209-03-P to prevent the dielectric from ooshing out during the step of  
soldering the outer braid (don’t apply more heat than needed).  The #1209-03-P is in the tools case on GSI desk in the lab. 
 
After assembly, always use the Maury Microwave A027A gage kit to ensure the pin depth and dielectric depth are in spec. 
Don’t let any out-of-spec cables get in the lab.  Out-of-spec cables can crush the fingers in the connectors on the ECal! 

51 Note:  Amphenol RF is different than Amphenol Connex.  Look on www.amphenolrf.com.    
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The web page for these AmphenolRF #901-9808 captivated-contact connectors we’re using is here: 
 
www.amphenolrf.com 
 
Then search for 901-9808: 

Click on Assembly Instructions 

http://www.amphenolrf.com/
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Clicking on Assembly Instructions will take you to this web page.  It says you’ll need to strip the cable 
0.125” (3.2 mm): 
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AmphenolRF 901-9809 captivated-contact SMA connector.  With a captivated-contact type of connector, when 
you buy the connector, the pin is already in the connector and set to the correct position.  Check the AmphenolRF 
web page for assembly instructions. 

Belden #1673A 0.141” outer 
diameter conformable coax 
cable.  The web page for the 
901-9808 connector should 
have a link to assembly 
instructions, which will tell you 
the distance to strip the 
conductor.  After stripping, push 
the center conductor into this 
hole on the backside of the 
connector.  Then solder the 
outer braid to the connector 
neck. 
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SanTron assembly tool, #1209-03-P.  This is kept in the plastic box with the cable making tools on the GSI’s desk 
in Cory 111.  Use it when making these types of cables.  The pictures below show each end of the tool.  Screw in 
the end shown on the right into the connector your assembling onto the conformable cable.  When you solder 
the outer braid of the conformable cable onto the neck of the connector, the heat from the soldering iron can 
cause the dielectric to move.  This tool prevents that from happening, or tries to.  Don’t apply more heat than 
you need to.  If you do, the dielectric face will end up out of spec.  Always measure the pin-depth and dielectric-
depth, using the gages, both before and after assembly.  
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Strip the cable to the appropriate length, then file the tip of the inner conductor to take off any burrs (while looking 
under the stereo microscope).  A wire stripper and a file are in the plastic box on the GSI’s desk.  Check it under the 
stereo microscope for any metal debris sitting on the insulator’s face.  Get rid of them by blowing with air, or 
picking them out with a razor blade (also in the plastic box).  The goal is to make a clean interface between the 
cable and the connector so as to create as uniform of a transmission line as possible.  

Then push the connector onto the cable.  Push it all the way in. 

Next, screw the Santron 1209-03-P tool 
into the SMA connector.  The Santron 
tool acts as a heat sink during soldering. 



57 

After soldering the outer braid to the connector neck, use needle-nose pliers and bend some Bend-and-Stay wire 
to add rigidity to the cable.  The point of failure will always be at the solder joint at the neck, so you never want to 
bend the cable there when you’re doing measurements on the VNA.  Wrap bend-and-stay wire tightly at the neck, 
with wider-spaced wraps for the next two inches, followed by several tight turns at the end.   

Use flux and solder the outer braid to the connector neck.  You 
don’t need to use huge amounts of solder, but you do need to 
do both sides to get solder all the way around.  Again, you’re 
trying to make a uniform coaxial transmission line, so you want 
the outer braid to make good contact circumferentially around 
the neck of the SMA connector. 
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Now get the 2-part epoxy and a mixing stick from the plastic box on the GSI’s desk. 

Fold the pack in half, cut 
through both parts with 
scissors, and squeeze out 
the entire contents of 
both packs. 
 
Mix thoroughly. 
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Put a small amount of epoxy on your mixing stick and apply a thin layer of epoxy over the Bend-and-Stay wire. 

Make sure not to get any epoxy in this 
rotary joint. 

Hold in a vise at the middle of the cable 
and let dry overnight.  Check that the nut 
rotates freely and that you didn’t get any 
epoxy in the joint. 
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Uses the gages to make sure the pin-depth and dielectric depth are within spec: 



61 

Never bend these cables like this at the solder joint. Keep them straight up until this point. 

When done assembling, test the cable on the network analyzer.  Use the 3 tests for cable stability:  1) the LogMag test 
2)  the SWR test and 3) the Phase test. 
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